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Abstract 

 

 

Key features 
• Infection-based analysis of bacterial-mediated suppression of host trafficking to lysosomes, using Salmonella 

enterica serovar Typhimurium infection of human epithelial cells as a model. 

• Live microscopy–based analysis allows for the visualization of individually infected host cells and is amenable to 

phenotype quantification. 

• Assay can be adapted to a broad array of pathogens and diverse host cell types. 

• Assay can identify virulence factors mediating a phenotype and protein domains that mediate a phenotype. 
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Intracellular bacterial pathogens have evolved to be adept at manipulating host cellular function for the benefit of 

the pathogen, often by means of secreted virulence factors that target host pathways for modulation. The lysosomal 

pathway is an essential cellular response pathway to intracellular pathogens and, as such, represents a common target 

for bacterial-mediated evasion. Here, we describe a method to quantitatively assess bacterial pathogen–mediated 

suppression of host cell trafficking to lysosomes, using Salmonella enterica serovar Typhimurium infection of 

epithelial cells as a model. This live-cell imaging assay involves the use of a BODIPY TR-X conjugate of BSA (DQ-

Red BSA) that traffics to and fluoresces in functional lysosomes. This method can be adapted to study infection with 

a broad array of pathogens in diverse host cell types. It is capable of being applied to identify secreted virulence 

factors responsible for a phenotype of interest as well as domains within the bacterial protein that are important for 

mediating the phenotype. Collectively, these tools can provide invaluable insight into the mechanisms of 

pathogenesis of a diverse array of pathogenic bacteria, with the potential to uncover virulence factors that may be 

suitable targets for therapeutic intervention. 
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Background 
 

Bacterial pathogens employ diverse strategies to manipulate host cellular function to establish infection [1]. Among 

the many approaches, modulation of host cells can occur at the level of immune signalling and immune cell function 

[1,2], cellular immune responses such as lysosomal and autophagy function [3–6], organelle function [7,8], or 

cytoskeletal dynamics [1,9,10]. The lysosomal pathway represents a fundamental signalling hub and cellular 

immune response pathway in eukaryotic cells [11,12]. Lysosomes are membrane-bound organelles responsible for 

the degradation of proteins, lipids, nucleic acids, and carbohydrates [11,12]. These vesicles exhibit a 

characteristically low pH that promotes the activation of over 60 different hydrolases, ultimately contributing to 

cellular homeostasis and clearance of intracellular pathogens [11,12]. Defects in lysosome function can lead to one 

of more than 50 different disorders, collectively defined as lysosome storage diseases, with implications in 

neurodegeneration and aging [12–15].  

Given that lysosomes function as a primary organelle responsible for the clearance of intracellular bacterial 

pathogens, they represent an important target for pathogen manipulation. Intracellular bacteria have evolved diverse 

mechanisms to manipulate host function to evade lysosomal degradation [2,10]. Lysosomal evasion can occur 

through either direct or indirect means. An example of an indirect mechanism of evasion is the manipulation of host 

trafficking to acquire membrane from other organelles. For example, the pathogen Legionella pneumophila uses a 

cooperative approach involving a series of secreted virulence proteins to acquire membrane from the endoplasmic 

reticulum [16]. This acquisition of membrane disguises the pathogen-containing vacuole as the host compartment, 

ultimately evading detection by the lysosomal pathway [17]. Many pathogens have evolved more direct means of 

targeting lysosomal function [10,18]. For example, the foodborne pathogen Vibrio parahaemolyticus uses the 

secreted virulence protein VepA to target the lysosomal V-ATPase and induce lysosome rupture [5]. 

Effective characterization of pathogen-mediated suppression of host lysosome function involves identifying the 

mechanism of host evasion and ultimately establishing the mechanism of action of the virulence factor responsible. 

This requires the development of robust cell biological assays for the study of these phenotypes. Among the most 

commonly proposed direct mechanisms of evasion is the suppression of trafficking of host lysosomes [10, 18]. Here, 

we describe a host–pathogen infection assay that can be used to investigate this phenotype [19]. This fluorescence-

based microscopy assay involves the use of a BODIPY TR-X conjugate of BSA (DQ-Red BSA). This highly labelled 

BSA derivative exists as a self-quenched, non-fluorescent form (Figure 1A) and, upon treatment of host cells, is 

internalised by endocytosis. Upon trafficking to functional lysosomes, the acquisition of lysosomal proteases results 

in BSA cleavage, resulting in unquenching and bright-red fluorescence [20]. DQ-Red BSA is a substrate for a broad 

array of lysosome hydrolases and, therefore, is capable of detecting global lysosome function [21].  

 

 
 

Figure 1. DQ-Red BSA assay for bacterial pathogen–mediated suppression of host trafficking. A. DQ-Red 

BSA dye mechanism. The fluorophores within the DQ-Red BSA dye exist in a quenched form and therefore do not 

generate intrinsic fluorescence. When host cells are treated with the dye, the compound is internalised by general 

endocytic mechanisms, and is trafficked to intermediates of the endocytic pathway. When dye-containing vesicles 

are trafficked to lysosomes, active lysosomal proteases cleave the BSA backbone, resulting in unquenching of the 

fluorophores and the generation of bright-red fluorescence. B. Host–pathogen infection assay to assess suppression 
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of host lysosomal trafficking. Host cells are seeded in a microscopy chamber slide and infected with the bacterial 

pathogen of interest expressing green fluorescent protein (GFP). At the timepoint of interest, cells are subjected to 

a pulse-chase with DQ-Red BSA. Infected host cells are imaged by fluorescence microscopy, and suppression of 

host lysosome trafficking is quantified by imaging software. 

 

The following summarises a method to quantitatively assess bacterial pathogen–mediated suppression of host cell 

trafficking to lysosomes, using Salmonella enterica serovar Typhimurium infection of epithelial cells as a model 

(Figure 1B). S. enterica is a Gram-negative pathogen that is among the leading causes of foodborne gastroenteritis 

worldwide [22]. As an intracellular vacuolar pathogen, S. Typhimurium evades targeting for death by lysosomes to 

establish a replicative niche within host cells [10]. S. Typhimurium was shown to suppress host trafficking to 

lysosomes (Figure 2) using this fluorescence microscopy–based imaging assay [19], which allows the visualization 

of trafficking to lysosomes in individual live-infected host cells alongside neighbouring non-infected host cell 

counterparts. This method was also used to identify the secreted virulence factor responsible for the phenotype, as 

well as domains within the bacterial protein that contribute to the phenotype [19]. The methods outlined highlight 

important considerations for adapting this method for the study of other host cell types and other bacterial pathogens, 

as well as for modifying the assay setup to tailor to the experimental question of interest. 

 

 
 

Figure 2. Salmonella virulence factor–mediated suppression of host trafficking to lysosomes. Salmonella 

Typhimurium manipulates the host cytoskeleton to direct its uptake into host epithelial cells using early-secreted 

virulence proteins. Upon uptake, Salmonella-containing vacuoles (SCVs) begin to undergo interactions with early 

intermediates of the endocytic pathway. As a mechanism of evasion, Salmonella produces late-secreted virulence 

proteins to suppress trafficking to lysosomes and promote intracellular survival and replication.  
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Materials and reagents 
 

Biological materials 

 

1. HeLa (ATCC, catalog number: CCL-2) 

2. Salmonella enterica serovar Typhimurium SL1344 harbouring pFPV25.1 [23]  

Note: The pathogen of interest must be expressing a fluorescent protein that is not associated with red 

wavelengths (e.g., GFP) for detection purposes. This may be in the form of a shuttle plasmid such as pFPV25.1 

(expressing GFP) or a strain harbouring a chromosomal insertion. Should this not be previously established 

for the pathogen of interest, broad host spectrum shuttle plasmids exist that might be worthy of investigation 

[24]. 

 

Reagents 

 

1. Dulbecco modified Eagle medium (DMEM), 4.5 g/L glucose, with L-glutamine, sodium pyruvate, and phenol 

red) (Wisent, catalog number: 319-005-CL) 

2. Fetal bovine serum (FBS) (Wisent, catalog number: 080-450) 

3. LB Miller broth (BioShop, catalog number: LBL407) 

4. Agar, bacteriological grade (BioShop, catalog number: AGR001) 

5. Streptomycin sulfate (BioShop, catalog number: STP101) 

6. Carbenicillin sodium salt (BioShop, catalog number: CAR544) 

7. Phosphate-buffered saline with calcium and magnesium (PBS+/+) (Wisent, catalog number: 311-011-CL) 

8. Gentamicin sulfate (BioShop, catalog number: GTA401) 

9. DQ-Red BSA (Thermo Fisher, catalog number: D12051) 

10. Phosphate-buffered saline without calcium and magnesium (PBS-/-) (Wisent, catalog number: 311-425-CL) 

11. Roswell Park Memorial Institute 1640 (RPMI), L-glutamine & HEPES, no sodium bicarbonate (Wisent, catalog 

number: 350-025-CL) 

 

Solutions 

 

1. Streptomycin stock solution (see Recipes) 

2. Carbenicillin stock solution (see Recipes) 

3. LB-agar solution (for LB-agar plates) (see Recipes) 

4. DQ-Red BSA solution (see Recipes) 

 

Recipes 

 

1. Streptomycin stock solution (1 mL) 

Note: Dissolve powder in water and vortex well until powder dissolves. In a sterile area such as a Bunsen 

burner or Class II biosafety cabinet, filter sterilise the stock into a sterile tube. 

Reagent Final concentration Quantity or Volume 

Streptomycin sulfate 50 mg/mL 50 mg 

Double-distilled water (ddH2O) n/a to 1 mL 

 

2. Carbenicillin stock solution (1 mL) 

Note: Dissolve powder in water and vortex well until powder dissolves. In a sterile area such as a Bunsen 

burner or Class II biosafety cabinet, filter sterilise stock into a sterile tube. 

Reagent Final concentration Quantity or Volume 

Carbenicillin sodium salt 100 mg/mL 100 mg 

Double-distilled water (ddH2O) n/a to 1 mL 
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3. LB-agar solution (500 mL) 

Note: Dissolve powder in water and mix well using a stir bar until powder dissolves as much as possible. 

Autoclave using standard settings for liquid laboratory media. Where supplementation with antibiotics is 

applicable, when the autoclaved media is cooled such that it is warm to the touch, add the appropriate 

concentration of antibiotic stock in a sterile area. After stirring on a stir plate, use a sterile area to pour a layer 

of agar-supplemented media in each Petri dish. Allow to solidify at room temperature and store solidified plates 

at 4 °C. 

Reagent Final concentration Quantity or Volume 

LB Miller broth (powder) 25 g/L 12.5 g 

Agar 15 g/L 7.5 g 

Double-distilled water (ddH2O) n/a to 500 mL 

 

4. DQ-Red BSA stock solution (1 mL) 

Note: Dissolve powder in PBS-/- and mix well by vortexing. If needed, sonicate to assist with solubilizing the 

reagent. Once solubilised, the reagent can be stored at 4 °C for several weeks. Note that DQ-Red BSA is light-

sensitive. Store in a sample tube that is either covered in foil or opaque and, wherever possible, handle in the 

dark. 

Reagent Final concentration Quantity or Volume 

DQ-Red BSA 2 mg/mL 1 mg 

PBS-/- n/a to 500 μL 

 

 

Laboratory supplies 

 

1. Glass-bottom microscopy chambers (ibidi, catalog number: 80827-90) 

2. Centrifuge tubes, polypropylene, sterile (Corning, catalog number: C352098) 

3. Serological pipettes, sterile (Sarstedt, catalog number: 86.1253.001) 

4. Petri dishes for bacteriology, sterile (Sarstedt, catalog number: 82.1473.001) 

5. Round-bottom culture tubes, sterile (Corning, catalog number: C352059) 

6. Syringe, sterile (BD, catalog number: B309659) 

7. Syringe filter, sterile (Millipore Sigma, catalog number: SLGP033RS) 

8. Magnetic stir bar (Fisherbrand, catalog number: 800371113) 

 

 

Equipment 
 

1. CO2 incubator (Nuaire, model: NU-425-400) 

2. Bacterial incubator (New Brunswick, model: Innova 42) 

3. Quorum spinning disk fluorescence microscope (Leica, model: DMIRE2, Hamamatsu, model: CMOS FL-400)  

4. Bunsen burner (EISCO, model: CH0095B) or Class II biosafety cabinet (Nuaire, model: NU-602-600) 

5. Analytical balance (Mettler Toledo, model: ML304T) 

6. Stir plate (Thermo Scientific, model: SP131525) 

7. Autoclave 

8. Vortex (VWR, model: G-560) 

9. Microcentrifuge (Eppendorf, model: 5425) 

 

Software and datasets 
 

1. Fiji (ImageJ, v1.54f 29, June 2023) (free analysis software) 
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Procedure 
 

A. Bacterial pathogen infection 

 

The following method is used for the study of S. Typhimurium infection of host epithelial cells (Figure 1B). 

The protocol is adaptable for infection with diverse intracellular pathogens and a broad array of cell types. 

Highlighted within the protocol are important considerations for tailoring this assay to study different host cell 

types, pathogens, and applications. Information is also provided regarding commonly encountered challenges 

and suggested troubleshooting strategies. 

 

1. Seed host cells in glass-bottom microscopy chambers. For comparison studies, such as identifying 

virulence factor(s) associated with the phenotype or domains within the virulence factor responsible for 

function (additional information in Table 1), one well is needed per strain. For analysis of S. Typhimurium 

infection of HeLa cells, seed μ-Slide 8-well glass-bottom chambers with HeLa cells at 6 × 104 cells/well 

using DMEM supplemented with 10% FBS as a culture medium. 

Note: For comparison studies with isogenic knockout strains, the use of a complementation strain is 

required to rule out the possibility of polar effects. Complementation plasmids for these purposes have 

been established for diverse intracellular pathogens.  

 

Table 1. Applications of DQ-Red BSA assay for the study of bacterial pathogenesis 

Assay purpose Bacterial strains required Additional information and considerations 

Validation of suppression 

of host lysosomal 

trafficking 

Wildtype 

• Kinetics of trafficking suppression may vary by 

strain and host cell line; if the timepoint of interest 

has not been established, a time-course analysis may 

be needed 

• Seeding: one well per timepoint of interest 

Virulence factor 

identification 

Wildtype, isogenic 

knockout(s), 

complementation strain(s) 

• If needed, assay can be scaled down to a smaller 

format to be amenable for larger scale screen of 

knockouts 

• Once a candidate virulence factor is identified, the 

experiment must be repeated in comparison to a 

complementation strain  

• Complementation: all strains must harbour the 

same complementation base plasmid, either with or 

without the virulence factor gene of interest 

Virulence factor domain 

mapping 

Wildtype, isogenic knockout, 

complementation strains 

harbouring wildtype and 

truncation mutants 

• All strains must harbour the same complementation 

base plasmid, either with or without the virulence 

factor gene of interest 

• For virulence factors with limited information, in 

silico tools such as Phyre2 [26] may provide 

valuable insight to guide hypotheses 

• If the virulence factor has known or predicted 

catalytic sites or functional residues, point mutations 

can also be assessed in parallel  

 

2. Grow host cells in a CO2 incubator until the optimal confluency for infection of the pathogen of interest. 

For S. Typhimurium infection of epithelial cells, incubate overnight until host cells are at a confluency of 

70%–80%. 

3. Concurrently, prepare the pathogen inoculum so that it is ready for infection when the host cells are at the 

optimal level of confluency for infection. For S. Typhimurium SL1344 harbouring pFPV25.1, this requires 

setting up an overnight culture on the day of seeding host cells. Inoculate a sterile bacterial culture tube 

with 2 mL of LB supplemented with 50 μg/mL streptomycin (for selection of the strain) and 100 μg/mL 
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carbenicillin (for selection of pFPV25.1) with several single colonies grown on LB-agar supplemented 

with 50 μg/mL streptomycin and 100 μg/mL carbenicillin. Incubate for 16 h at 37 °C and 250 rpm. 

4. On the day of infection, prepare the pathogen inoculum as required prior to infection. For S. Typhimurium 

SL1344 infection of epithelial cells, in a sterile 125 mL flask containing 10 mL of LB, subculture from the 

overnight culture (1:33) [25] and incubate for 3 h at 37 °C and 250 rpm. Prepare inocula by pelleting 1 mL 

of the culture at 10,000× g for 2 min, resuspending the pellet in PBS+/+ to 1 mL, and diluting in PBS+/+ to 

the appropriate multiplicity of infection. For S. Typhimurium SL1344, 1:100 is suggested. 

Note: The goal of this experimental setup should be to have host cells infected with the intracellular 

pathogen such that, at the time of microscopy analysis, primary infected cell(s) are in the same field of 

view with neighbouring non-infected host cells. The multiplicity of infection and host cell confluency can 

be adjusted during the optimization process to achieve this. 

5. Aspirate culture medium from host cells and wash with 200 μL of PBS+/+. Apply bacterial inoculum as 

previously established for the pathogen of interest. A volume of 200 μL is suggested. For S. Typhimurium 

infection of epithelial cells, incubate infected host cells in CO2 incubator at 37 °C for 10 min.  

6. After the appropriate amount of time previously established for the pathogen, aspirate the bacterial 

inoculum from the host cells and wash three times with PBS+/+. Apply growth medium appropriate for the 

host cell type of interest and incubate in CO2 incubator. 

Note: Prewarm all culture media used in this experiment to 37 °C. This step is important to allow 

completion of bacterial uptake such that the pathogen-containing vacuole has completed fission from the 

host plasma membrane. Proceeding to Step A7 too early could result in bacterial killing and therefore little 

or no infected host cells. 

7. At the appropriate timepoint for the pathogen, change the culture media to growth medium supplemented 

with antibiotic for the selection of intracellular bacteria. For S. Typhimurium SL1344 infection of epithelial 

cells, change the media at 30 min post-infection (p.i.) to DMEM supplemented with 10% FBS and 100 

μg/mL gentamicin [19]. At 2 h p.i., change the media to DMEM supplemented with 10% FBS and 10 

μg/mL gentamicin for maintenance purposes. 

Note: Selection for intracellular bacteria is essential to ensure that the phenotype of interest is not due to 

factors produced by extracellular bacteria. The antibiotic of interest is chosen based on previous 

knowledge about antibiotic internalization into host cells. For example, gentamicin is commonly used 

because of its limited penetration into a wide range of host cells, allowing selection for intracellular 

bacteria [27]. The sensitivity profile of the pathogen strain of interest, as well as previously established 

acceptable antibiotic concentration ranges for host cell treatment, will affect the concentration selection. 

With respect to pathogen sensitivity, this information has been previously established in the literature for 

many intracellular pathogens. If unknown for the pathogen of interest, a minimum inhibitory concentration 

assay can be performed. 

8. At the timepoint of infection where the suppression of host trafficking to lysosomes occurs, change media 

to the culture medium used at the end of Step A7 supplemented with DQ-Red BSA. For S. Typhimurium 

infection of HeLa cells, perform this step at 8 h p.i. using DMEM supplemented with 10% FBS, 10 μg/mL 

gentamicin, and 0.25 mg/mL DQ-Red BSA [19].  

Note: The infection timepoint associated with the phenotype will most often be determined based on 

previous literature for the pathogen. Should the pathogen be poorly understood in this context, a series of 

timepoints can be investigated to determine this. The concentration of DQ-Red BSA for treatment will vary 

depending on the cell line used and its ability to uptake dye. For example, for phagocytic RAW 264.7 cells, 

a concentration of 10 μg/mL may be used [19]. This is often previously established in the literature but 

may be optimised experimentally if needed. 

9. Incubate in CO2 incubator for 1 h. This treatment, with culture medium supplemented with dye, is called 

the pulse step. 

Note: The pulse period can be adjusted if 1 h proves to be ineffective for the cell type of interest. 

10. Wash infected host cells with PBS+/+ and change media to the culture medium used at the end of Step A7. 

Incubate in CO2 incubator for 4 h. This incubation in the absence of dye to allow for trafficking to 

lysosomes is called the chase step. 

Note: This chase period will allow the DQ-Red BSA to traffic to lysosomes for detection. The time period 
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associated with this step may vary depending on the cell line. Should the pathogen of interest function to 

block trafficking to lysosomes, DQ-Red BSA trafficking should occur at a reduced level. 
11. Wash infected host cells with PBS+/+ and change medium to HEPES-buffered RPMI 1640 or an equivalent 

culture medium with HEPES buffer, supplemented with 10% FBS and the antibiotic used for intracellular 

selection (10 μg/mL gentamicin for S. Typhimurium). The infected sample is ready for live imaging by 

fluorescence microscopy. 

Note: The HEPES-buffered media is used to allow live-cell imaging on a routine microscope. Should the 

microscope of interest be outfitted with a CO2-infused system, a culture medium with sodium bicarbonate 

may be used. 

 

B. Fluorescence microscopy imaging and image quantification 

 

1. On a fluorescence microscope with a 40× or 63× objective, examine each chamber for primary infected 

cells in the channel associated with the fluorescent protein expressed. For S. Typhimurium SL1344 

expressing pFPV25.1, use the green channel. For each infected host cell identified, examine the field of 

view for an adjacent non-infected cell. Image each field of view, capturing the channel to image the 

bacterially expressed fluorescent protein and DQ-Red BSA (Figure 3). Host cells can also be captured in 

the differential interference contrast (DIC) channel to assist with identifying cell boundaries. 

 

 
 

Figure 3. DQ-Red BSA assay: Salmonella-infected epithelial cells. HeLa cells were infected with 

wildtype Salmonella enterica serovar Typhimurium SL1344 harbouring the GFP-expressing plasmid 

pFPV25.1 (green) for 8 h. Cells were subjected to a pulse-chase with DQ-Red BSA (red) and subsequently 

imaged live. The scale bar represents 10 μm.  

 

2. Continue imaging as described in Step B1. For each strain of interest, it is ideal to capture images of at 

least 100 infected cells with adjacent non-infected counterparts.  

Note: If the microscope is outfitted with a platform capable of automated imaging, capture as many fields 

of view as required to fulfil the criteria described above.  

3. Analysis can be performed using the commonly available software Fiji (ImageJ). Open imaging file of 

interest in the software (Figure 4A). 

Note: An equivalent analysis can be performed using other microscopy analysis software, such as Volocity. 

4. For each primary infected cell, assess fluorescence intensity per area in the DQ-Red BSA channel: 

a. Open the image of interest. To assist with assessment, use the Composite setting to allow all channels 

to be visualised as an overlay. 

b. Open the Channels Tool (Image → Color → Channels Tool) to allow for the turning on and off of 

individual channels. 

c. To select which measurements will be performed, go to Analyze → Set Measurements. Select Area 

and Mean Value. 

d. Open ROI Manager by selecting Analyze → Tools → ROI Manager. 

e. As the DQ-Red BSA channel will be measured, use the slider at the bottom of the image to select the 

corresponding channel. 

f. Select the Freehand Tool (Figure 4B). 
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Figure 4. Fiji analysis of DQ-Red BSA assay: Salmonella-infected epithelial cells. (A) Cells should be 

imaged such that each field of view contains an infected cell of interest and a neighbouring non-infected 

cell. Visualization in the Composite mode allows for the viewing of both bacterial (green) and DQ-Red 

BSA (red) channels simultaneously. (B) DQ-Red BSA quantification is performed in Fiji. The Freehand 

Tool is used to outline both infected and non-infected cells as regions of interest (ROIs) prior to 

measurement using ROI Manager. 

 

g. Draw a region of interest corresponding to the cell boundary of the infected host cell. 

h. In ROI Manager, add the newly selected ROI by clicking Add. 

i. Draw a region of interest corresponding to the cell boundary of the neighbouring non-infected host 

cell. 

j. In ROI Manager, add the newly selected ROI by clicking Add. 

k. To take measurements, in ROI Manager, select Measure. A Results window will appear with the 

corresponding measurements for the two ROIs. These values can be copied and pasted into Excel for 

subsequent analysis. 

l. Repeat steps B4g–k for all images of interest. 

Note: Should the host cell type demonstrate abnormal cells that are characteristically smaller and/or 

larger than normal cells, a size threshold range can be predetermined such that abnormal cells are 

excluded from analysis. Also, if needed, a background correction can be performed. 

 

 

Data analysis 
 

1. For each primary infected cell and its neighbouring non-infected host cell counterpart, individually calculate 

the associated intensity/µm2 of the DQ-Red BSA channel by dividing the total intensity measured for the ROI 

(mean value) by the area of the ROI (area). 

2. For each primary infected cell and its neighbouring non-infected host cell counterpart, calculate the 

intensity/µm2 of the infected cell as a percentage of the non-infected comparison. This can be accomplished by 

dividing the intensity/µm2 of the infected cell by the intensity/µm2 of the non-infected cell and multiplying by 

a factor of 100.  

3. Repeat steps 1 and 2 for each primary infected cell and neighbouring non-infected cell set. A total of 100 data 

points is ideal.  

4. For each strain or condition of interest, calculate the mean of the 100 data points. For comparison studies of 

wild type with isogenic knockout strains and complementation strain(s), mean DQ-Red BSA signal 
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intensity/µm2, presented as a percentage of control (non-infected cells), can be compared by bar graph. 

 

Note: Should the data indicate a statistically significant difference with a new pathogen, or should a virulence factor 

be implicated, a supplementary analysis is needed to rule out the possibility of a defect in dye internalization. This 

can be performed as a separate independent assay or in combination with DQ-Red BSA using a secondary dye (e.g., 

dextran Alexa Fluor 647) [19]. Also, it would be valuable to consider validating that DQ-Red BSA dye uptake in 

non-infected cells is equivalent to that of uninfected cells. To assess this, a comparison of uninfected conditions can 

be performed for subsequent analysis. 

 

 

Validation of protocol 
 

This protocol or parts of it has been used and validated in the following research article: 

• D’Costa et al. [19]. Salmonella Disrupts Host Endocytic Trafficking by SopD2-Mediated Inhibition of Rab7. 

Cell Reports (Figure 1, panels A–D; Figure 3, panels C–D; Figure 5, panel B; Supplemental Figure 1, panels 

A–C; Supplemental Figure 2). 

 

 

General notes and troubleshooting 
 

Troubleshooting 

 

Problem 1: Poor infection efficiency. 

Possible cause: Suboptimal host cell conditions. 

Solution: Host cell confluency can affect bacterial uptake. If this is suspected, a confluency assessment can be 

performed by seeding at several host cell densities. 

 

Problem 2: Poor infection efficiency. 

Possible cause: Suboptimal bacterial inoculum. 

Solution: A colony-forming unit analysis of the inoculum can be performed to confirm that the bacterial growth 

conditions resulted in viable bacteria. If applicable, it may also be possible that virulence factor production to induce 

uptake was suboptimal. As virulence factor production in pathogens such as Salmonella can be growth phase–

dependent, a growth curve analysis can be performed to assess this. 

 

Problem 3: No intracellular bacteria. 

Possible cause: Ineffective intracellular protection conditions. 

Solution: If intracellular protection is performed before pathogen uptake into intact pathogen-containing vacuoles 

is complete, the antibiotic is accessible to the bacteria, which will subsequently be targeted for death. The time 

period prior to antibiotic treatment can be increased if needed. 

 

Problem 4: Extracellular bacteria observed. 

Possible cause: Ineffective intracellular protection conditions. 

Solution: Perform a minimum inhibitory concentration assay with the strain of interest to confirm its sensitivity to 

the antibiotic of interest. This may indicate that a slight adjustment in the drug concentrations used in the assay may 

be needed. If the strain is resistant to the antibiotic of preference (e.g., gentamicin), an alternate drug class may be 

considered (e.g., polymyxins). 

 

Problem 5: DQ-Red BSA signal is too low. 

Possible cause: Low sensitivity microscopy system. 

Solution: Increase light source intensity or exposure length. 
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Problem 6: DQ-Red BSA signal is too low. 

Possible cause: Suboptimal dye uptake. 

Solution: The pulse treatment conditions may need optimization, depending on the intrinsic uptake properties of the 

host cell line. If needed, consider increasing the dye concentration or uptake period.  
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